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Telling your M.E. story
Michael Williams says everyone has a story to tell, but not everyone is heard. He is right and 
it is up to us all to get the voices of people with M.E. listened to.

Michael is an independent professional storytelling consultant, facilitator and coach who 
has worked closely with us, expertly guiding our hand to enable us to achieve our 
innovative Digital Storytelling pilot project in Scotland.

Raising awareness and understanding of M.E. is a key priority for Action for M.E. It is one of 
five that shape our current and future activities and is at the heart of everything we do.

That’s why I was intrigued when Katrina Allen, our Project Co-ordinator for Scotland, 
mooted the idea of a Digital Storytelling project. I was delighted when Michael and film-
maker Paul Maguire said they could turn the idea into reality.

What better way to raise awareness and understanding than by empowering people 
affected by M.E. to talk about their own experience of this dreadful illness? To give them 
the tools, and indeed the confidence, to tell their story so that it has impact, is enlightening 
and takes people by the hand on a journey to enhance their understanding of M.E.

We also wanted to use the latest digital technology to empower those taking part in our 
project to share their M.E. stories with as wide an audience as they choose.

I would like to thank all those who took part in our pilot project for giving their time and 
precious energy to sharing their experience of M.E. with others. This illness is complex, with 
different people affected in different ways and to varying degrees of severity. What the 
storytelling project does is focus on the human face of the condition. 

The individual online videos produced by those who took part in the pilot project – 
available to view via our YouTube channel at www.tinyurl.com/actionformeyoutube – are,  
by their nature, very personal. They show how M.E. impacts on the very real lives of very real 
people.

Sharing their stories with a wider community and empowering more people to make similar 
contributions means the project is sustainable and ongoing. 

This toolkit provides a step-by-step guide to telling your own M.E. story, simply, succinctly 
and effectively. It guides you through the process of making your own digital film, outlining 
what equipment you need, how best to use it and provides some top tips on film-making.

The toolkit is designed to enable people affected by M.E. to work at their own pace while 
managing their symptoms. Remember, the only deadline is the one you set yourself.

The storytelling techniques and film-making tips outlined in this toolkit will also be of use to 
people wishing to raise awareness of other long-term conditions and we are pleased to be 
able to share them.
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I am also extremely grateful to our project funders, the Scottish Health and Social Care 
ALLIANCE and the Scottish Government through the Self-management Impact Fund, for 
their financial support. Without this backing, this extremely successful project would have 
remained just a great idea.

The success of the project was showcased at our Journeys with M.E. film screening and 
workshop during M.E. Awareness Week 2014. Thank you also to the Edinburgh-based 
Scottish Storytelling Centre which hosted the events at its excellent venue. 

Finally, I would like to again thank Michael and Paul for all the work they have put in to this 
project – not least in producing this toolkit. Their skills, knowledge and total professionalism 
have been invaluable. We could not have done it without you.

Sonya Chowdhury 
Chief Executive 
Action for M.E.
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Getting started
In this section, we invite you to discover and share your 
story. What needs to be told? Why? What do you want 
others to hear and do?

“There is no greater agony than bearing an untold story 
inside you.”
Maya Angelou

1
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Key points

1. Share your story with a trusted friend.

2. Identify the core message of the story? What do you want people to hear or 
experience?

3. Create a storyboard. Stories need a narrative order (beginning, middle, end) –  
see the hero’s journey template on p 14.

4. Consider the “language” of your story – words, images, sounds, music, silence.

5. Consider the emotional “tone” of your story – angry? humorous? factual?

6. Reveal the impact your illness has had on your life.

7. What do you want the audience to do?

Creating a personal narrative

This project invites you to create a personal narrative and express it through the medium of 
video. Before you start filming, however, you need a story or narrative to share. And stories 
need structure, at the very least a beginning, middle and end. This story will very likely be 
autobiographical; in others words, it’s about you, about something meaningful you have 
experienced in your life.

You’re going to tell your story in a concise manner – in about three to five minutes – so 
you’ll need a good narrative strategy and you won’t want to get bogged down in details. 
Before you begin, consider the following questions:

1. Are you able to share this story with others? (issues of vulnerability, confidentiality)

2. Will your audience be able to relate to your story and what you have learned? 
(relevance)

3. What do you want your audience to learn from your story? What do you want them to 
do? (education, motivation, action)

4. What does the audience need to know before you begin? Where? When? Who? How? 
What? (context, background)
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Discovering and sharing your story

Perhaps one of the most vulnerable things we are asking you to do is to share your story. 
Your first response might be, “I don’t have a story to tell.” Let us reassure you – you do have 
a story and stories want to be told. Human beings are natural storytellers; in fact, 
storytelling is one of the oldest, if not the oldest, forms of artistic expression.

What we can offer are some skills, techniques and information which can encourage and 
enable you to tell your story using the medium of video. We have adopted a “low-
definition” approach believing that participants can create compelling video (digital) stories 
using simple technology in the form of readily available cameras, computers and software.

This toolkit is built around the use of smartphones (eg. Android, iPhone and the like), point-
and-shoot digital cameras and video cameras. Participants will also need access to a laptop 
or desktop computer that uses either Windows Live Movie Maker or Apple Mac’s iMovie. 
Both of these pieces of video-editing software are normally supplied free of charge with the 
operating system but they can also be downloaded. The links below to go to the 
manufacturer’s download page depending on what operating system you are using.

http://windows.microsoft.com/en-gb/windows-live/movie-maker 
(free download from Microsoft)

https://www.apple.com/uk/mac/imovie

Note: your version may differ slightly from the versions referred to here but you should still 
find these notes helpful. However, there are numerous tutorials online (eg. YouTube) to help 
you with all aspects of these software packages.

Don’t worry if you’ve never used the video function on your smartphone or camera or if you 
had no idea that Movie Maker or iMovie were on your computer. This toolkit is aimed at the 
relative beginner. All we ask is that you have basic computer and internet skills and are not 
afraid to learn more.

http://windows.microsoft.com/en-gb/windows-live/movie-maker
https://www.apple.com/uk/mac/imovie
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Getting started

Exercise 1: Discovering and sharing your story

The first thing we invite you to do is to spend some time thinking of the story of your illness. 
Here are some questions to ponder:

•	 When did you first become aware of your illness?

•	 What were the symptoms?

•	 What prior knowledge of the illness did you have if any?

•	 What were the effects on your everyday life?

•	 What emotions arose?

•	 How did the illness affect your relationships with others?

•	 What treatment did you seek and receive, if any?

•	 What’s your current condition?

•	 Do you believe your illness is bringing you a message? If so, what insights have you 
gained?

When you’re ready, we’d like you to find a trusted friend or partner (if working in a group) 
with whom you can share your story. Instruct your listener to simply listen, to create a safe 
space for your story to emerge.

Your listener should not interrupt by attempting to “fix the problem,” or reassure you that 
everything will be ok, or over-empathise with you. It is ok, of course, to indicate or convey 
that they are interested and caring. And interruptions are acceptable if your partner doesn’t 
hear you or requires clarification on something you said.

If working in a group with others challenged by the illness, you will also offer your partner 
an opportunity to share their story while you provide the listening. When you’ve finished, 
invite your partner to share what they heard by asking them to summarise the story so that 
you can be sure that they have heard you accurately.

At this point, you may want to take a break and write, draw or scribble in your journal, 
making notes and reflections on what you’ve said and heard. Note also how you feel at this 
point or sketch/make a note of any images, words, sounds that arise. These could be used 
later in the creation of your video.
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Exercise 2: Transforming experience into art

If time permits, I recommend the following exercise as a way of experiencing how art can 
transform and offer meaning to the events of our lives. It can also give you space or 
objectivity so that you can experience your story in a different way.

Once you and your partner have told and listened to your stories, I invite you to re-tell the 
story you heard back to your partner in the form of a fairy or folktale.

Now at this point, many people become anxious or frightened at the prospect of telling a 
tale while others can hardly be restrained from beginning. There’s no right or wrong way of 
feeling. But trust yourself, trust your imagination. If you still feel uncomfortable and wish to 
decline, that’s ok too.

I believe every human being is capable of telling a story. Beginning with the traditional 
“Once upon a time . . .” is often all it takes for the stories, their words and images, to start 
flowing.

We’re not looking for polished stories here, just heartfelt tales inspired by the factual story 
you heard from your partner. Give reign to your heart and imagination and body. Allow 
yourself to play like you did as a child. You’ll be surprised at what comes.

After each person has heard their experience transformed into a tale, take time to reflect. 
Again, write or sketch in your journal any words, images, sounds that come to mind. Share, 
if you wish, with your partner.

Afterwards, consider and reflect on the following questions. Again, you may want to share 
your answers with your partner or the group.

•	 What was it like to tell your (factual) story to someone else?

•	 What was it like to listen to someone else’s (factual) story of their illness?

•	 What was it like to tell someone’s story as a fairy or folktale?

•	 What was it like to listen to your own story told as a fairy or folktale?

The point of this exercise is to explore how art can transform our raw experience into 
something that is meaningful. In the genre of the fairy or folktale we are invited into a world 
of archetype and mythical pattern. Through these, the stories of our own lives can be cast 
and understood in the context of larger tales or metanarratives that have served humanity 
for ages. While our stories are unique they are also contained within the stories of human 
existence and suffering. We are not alone.
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Basic storytelling concepts

The following ideas and questions will help you structure your story and get you thinking 
about the basic narrative techniques that make a story compelling. They are not 
comprehensive and you are invited to explore books on narrative and storytelling (see 
Resources at the end of this toolkit).

Note: Don’t worry if you can’t answer all of these questions. They’re there to help you start 
thinking about your story and how you might present it.

1. Beginning or introduction

Get to the point! You want to grab your audience’s attention from the beginning. You could 
do this with a powerful image or statement or question. What do you want the audience to 
take away from your story? Asking a powerful question at the beginning is one way of 
getting your audience to get involved and to think (just make sure you answer the question 
by the end of the story).

2. Point of view

As this is your story, you will be speaking largely in the first person (I, me, we, us). Stay 
consistent. Also, ask yourself, “What’s my point?” What’s the main thought or feeling you 
want to convey?

3. Narrative order

Your story should follow some logical order. It should make sense. Chronological order is 
most common but you could use flashbacks. In our workshops, I introduced the archetypal 
template of the heroic journey (see p 14). For many, this is a popular and useful pattern 
upon which to weave your story.

4. Language

Think about the words and imagery you want to use. They should help convey your 
message. Write the name of your illness in the middle of a sheet of paper. Now draw a line 
out from the centre to a space where you can write the first word that comes to mind in 
response to that initial word. Don’t overthink. Write what comes to mind. Repeat this 
process again and again until the entire sheet is filled. Each time, repeat to yourself the 
initial word, draw a line out and write down your response. Write for at least 10 minutes.

Imagery – compare your illness to something else (an animal, weather, objects, etc). Write 
these images down as metaphors or similes (using “like” or “as”). Create comparisons 
using other senses besides sight. What does the illness sound like, smell like, taste like, feel 
like? For example:

•	 M.E. is like a black cloud on a grey day.

•	 My illness makes me feel as tired as a worn out, rusted tractor lying broken in an 
abandoned field.
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5. Emotions

What are your primary emotions in connection with the illness? What emotions have you 
encountered in others? What tone will your story carry? Anger? Humour? Pathos? Anxiety? 
Relief?

Note: You can download emotional vocabulary lists online.

6. Meaning and impact

Why and how has this illness made a difference in your life? Why is this difference 
meaningful? How have you changed? For the better or worse? Are you stronger for the 
experience? Or weaker? Do you think there is a meaning or message behind your illness?

7. Ending

Finally, does your story have a lesson or moral to share? Can you sum it up in a sentence or 
two? Do you have a clear sense of what you want the audience to do next?
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Storyboarding
In this section, we explore the structure of your story. All 
stories need a narrative order or structure – a beginning, 
middle and end. Storyboarding is a way of creating that 
structure so you can create a story with maximum impact.

“If people are telling you a story about themselves, they 
gradually map their own local territories and know themselves 
by them.”
Iain Sinclair, British writer and filmmaker

2
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Key points

1. Mapping your story and creating a storyboard

2. Hero’s journey template

3. Beginnings

4. Middles

5. Endings

6. The bones of your story

Mapping your story

A simple way of shaping our story is to map it out on a storyboard. A storyboard is like a 
comic book where the story is divided into panels. Each panel reflects a moment in the 
action or plot. Within each panel we see the character and read his or her thoughts or 
speech. We also get other information related to setting (time and place), plot, other 
characters, dramatic conflict and so on.

In this exercise we are going to think of our story in terms of key moments, images, 
problems, decisions and outcomes and map these out on our storyboard.

Begin by taking a sheet of A3 paper or flipchart paper. You can, of course, use A4 sheets (or 
smaller) but you will find larger sheets of paper give you greater scope for your imagination 
and artistic expression. We don’t want you feeling constrained.

Divide your sheet of paper into a 3x3 grid as shown on p 15.

You should end up with nine panels. Of course, you can vary this number to suit but 
restricting the number of panels to nine will help you keep focused on the core events or 
images rather than getting bogged down in too much detail. That will come later.
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The hero’s journey template

“If the hero’s not taking some kind of a journey, then there 
are no stakes – and no stakes, then you don’t care if he lives 
or dies, wins or loses.”
Brandon Lee, American actor
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than getting bogged down in too much detail. That will come 
later.

The Hero’s Journey template

“If the hero's not taking some kind of a journey, then there are no 
stakes - and no stakes, then you don't care if he lives or dies, wins 
or loses.”

! ! ! ! ! Brandon Lee, American actor

The hero’s journey is a useful narrative tool. The concept was 
developed by Joseph Campbell, an author and teacher who 
studied comparative mythology. In his seminal book, The Hero 
with a Thousand Faces (1949) Campbell identifies an arche-
typal pattern in the hero’s journey throughout world mythology. 
This pattern has been used countless times by scriptwriters, 
filmmakers, novelists and others. In fact, George Lucas hired 
Campbell to assist him in the structuring of the Star Wars film 
scripts.

Essentially, the hero’s journey breaks down into 3 phases: the 
call to adventure; the conflict; and the resolution.

I Call to Adventure

In this stage the status quo is disturbed. The hero is called to 
adventure, usually in the form of a journey (literal or metaphori-
cal). He or she may consciously decide to respond to the call or 
may be pushed into it. Heroes might even refuse the call initially 
but unless they sets out there’s not likely to be much of a story.

II The Conflict

Drama needs conflict. The 5 most common types of conflict are 
hero vs baddie; hero vs Nature; hero vs Supernatural; hero vs 
the collective; hero vs self. Stories often use combinations of 
these but the hero vs baddie (protagonist vs antagonist) is 
prominent. Traditionally, heroes encounters three challenges, 

The hero’s journey is a useful narrative tool. The concept was developed by Joseph 
Campbell, an author and teacher who studied comparative mythology. In his seminal book, 
The hero with a thousand faces (1949), Campbell identifies an archetypal pattern in the 
hero’s journey throughout world mythology. This pattern has been used countless times by 
scriptwriters, filmmakers, novelists and others. In fact, George Lucas hired Campbell to 
assist him in structuring the Star Wars film scripts.

Essentially, the hero’s journey breaks down into three phases: the call to adventure; the 
conflict; and the resolution.
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I Call to adventure

In this stage the status quo is disturbed. The hero is called to adventure, usually in the form 
of a journey (literal or metaphorical). He or she may consciously decide to respond to the 
call or may be pushed into it. Heroes might even refuse the call initially but unless they sets 
out there’s not likely to be much of a story.

II Conflict

Drama needs conflict. The five most common types of conflict are hero vs baddie; hero vs 
nature; hero vs supernatural; hero vs the collective; hero vs self. Stories often use 
combinations of these but the hero vs baddie (protagonist vs antagonist) is prominent. 
Traditionally, heroes encounters three challenges, each increasing in intensity or risk. With 
each encounter, heroes learn something more about themselves as well as the world 
around them.

III Resolution

As the action intensifies, heroes are called up on to resolve the conflict. Unless your 
intention is otherwise, audiences too require satisfaction. Heroes must overcome their 
difficulties; they must bring about a resolution to the mounting conflict. This is followed by 
a return to a new status quo in which the hero shares or celebrates his or her new-found 
knowledge, reward or other benefit with the community.

Think of the first row of your storyboard as representing the beginning of the story (call to 
adventure); the second row as the middle (the conflict); and the third row as your resolution 
or outcome.
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each increasing in intensity or risk. With each encounter, he-
roes learn something more about themselves as well as the 
world around them.

III The Resolution

As the action intensifies, heroes are called up on to resolve the 
conflict. Unless your intention is otherwise, audiences too re-
quire satisfaction. Heroes must overcome their difficulties; they 
must bring about a resolution to the mounting conflict. This is 
followed by a return to a new status quo in which the hero 
shares or celebrates his or her new-found knowledge, reward 
or other benefit with the community.

Think of the first row of your storyboard as representing the be-
ginning of the story (call to adventure); the second row as the 
middle (the conflict); and the third row as your resolution or out-
come.

First row (Beginning):

Panel 1 – what was the situation before the problem arose? 
This is the status quo, the time of stasis before everything 
changed.

Panel 2 – what happened that called you on your “journey”? 

Panel 3 – who or what were your helpers/mentors?

Second row (Middle):

Panel 4 – what was the first challenge or problem that pre-
sented itself? How was it overcome?

Panel 5 – what was the second challenge or problem that pre-
sented itself? How was it overcome?

Panel 6 – what was the third challenge or problem that pre-
sented itself? How was it overcome?

Third row (Ending)

StoryboardStoryboardStoryboard
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First row (beginning):

Panel 1 – what was the situation before the problem arose? This is the status quo, the time 
of stasis before everything changed.

Panel 2 – what happened that called you on your journey?

Panel 3 – who or what were your helpers/mentors?

Second row (middle):

Panel 4 – what was the first challenge or problem that presented itself? How was it 
overcome?

Panel 5 – what was the second challenge or problem that presented itself? How was it 
overcome?

Panel 6 – what was the third challenge or problem that presented itself? How was it 
overcome?

Third row (ending)

Panel 7 – At what point did you feel in the “belly of the whale”? This is the crisis or climax 
point of your story.

Panel 8 – What did you learn as a result of your experience? What were the lessons? 
Outcomes?

Panel 9 – How have you or how would you like to share your new-found knowledge or 
awareness with others?

Fill in each of these panels with a simple drawing. Artistic talent is not important. Stick 
figures or shapes will do. What’s important is that each panel tells a crucial part of the story. 
You can complement your figures with speech bubbles or a few words to help narrate the 
story. Again, don’t get bogged down in detail. You might want to use colour to express 
emotion rather than words.

Use the space below each panel to add notes.

When you have finished, share your storyboard with your partner or the group. You might 
want to post the storyboards on a wall and let others look at them and give you feedback.

Make any further notes or changes to your storyboard. Remember, storyboards are not 
written in stone. They are not the final interpretation of your experience. But they are a 
useful way to shape and structure your experience into a meaningful story.

Storytelling tip: Learning the bones of your story

It can be very useful to learn to tell your story to others. The storyboard can be a useful tool 
to help you remember the sequence without getting too bogged down in details. Visualise 
the journey and trust your imagination. The framework of the storyboard should allow you 
to weave words and images around it. Practise telling it to someone else. Telling the story 
brings it to life.
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Crafting your story
The storyboard gives you a framework upon which to 
weave your ideas. In this section we explore how to 
clothe this framework in your unique ‘language’ – words, 
sound, music, imagery, silence and narration.

“The greatest story commandment: make me care.”
Andrew Stanton, writer for Toy Story and WALL-E

3
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Key points

1. Keep it simple: make them care

2. Speaking to the camera

3. A day in the life

4. Light and shadow

5. Backdrops

6. Photographs

7. Special effects

8. Music

Narrative strategies

There is no one way to structure or film your story. You might choose a relatively simple 
method – speaking to the camera – or a more complex one involving lots of editing. My 
advice – especially if this is your first effort – is to keep it simple. And make your audience/
reader care about what you’re showing them or writing about.

First of all, let’s address the issue of technology. What equipment are we going to use? For 
the purposes of this kit, we’ve adopted a low-fi approach, using readily available, 
inexpensive equipment – digital cameras and camcorders, smartphones and tablets.
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Using video (technology)

Option 1 – Camcorders: a) tapeless digital, b) Mini DV / HDv

Option 2 – Smartphones: a) iPhone, b) Samsung

Option 3 – Tablets: a) iPad

Option 1: Camcorders

a) Tapeless digital

How to start using your camcorder to record video:

•	 Insert your memory card (e.g. SD, micro-SD, Compact Flash) unless you are using the 
camcorders internal memory

•	 Turn on the power to the camera.

•	 Press record to start and stop recording.

•	 You can then switch from “record” mode to “playback” mode to review your footage.

How to import your footage to a PC/Mac:

Most camcorders come with their own software to upload the footage to a PC/Mac by 
connecting the camcorder to the computer by either using a USB, DV or Firewire cable. You 
can also use editing software to import to a computer such as Move Maker (PC) or iMovie 
(Mac). You can connect the camera as mentioned above to the computer or insert your 
memory card into a USB card-reader and connect that instead.

b) Mini DV / HDv

How to start using your camcorder to record video:

•	 Turn on the power to the camera. Usually you can do this by switching the camcorder to 
“record” mode.

•	 Opening the camcorder tape deck and insert your mini DV or HDv tape and push it 
closed.

Note: Allow the tape deck mechanism to automatically retract into the camcorder.

•	 Press record to start and stop recording.

•	 You can then switch from “camera” mode to “playback” mode to review your footage.

Note: Remember to bring the tape back to where you stopped recording so as to not 
record over the footage you just shot.

How to import your footage to a PC/Mac:

The easiest way to import your tape footage to a computer is to use editing software such 
as Move Maker (PC) or iMovie (Mac). You can connect the camcorder to a computer by 
either using a USB, DV or Firewire cable that will usually come with the camcorder.

[Please see Section 3: Editing/Producing Digital Videos for the next step in importing your 
videos.]
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Option 2: Smartphones

a) iPhone (Instructions may vary according to what 
version you are using)

How to record video on Your iPhone:

•	 Tap the Camera icon on the Home screen. Your 
iPhone becomes a camera, with the screen as 
viewfinder.

•	 Drag the little onscreen button at the bottom-
right corner of the display from the camera 
position to the video camera position.

•	 (Optional) Tap the LED Flash button. Tapping 
this button shines a light while you record video.

•	 Tap the red record button at the bottom center 
to begin shooting a scene. The button blinks and 
a counter timing the length of your video 
appears.

•	 When you’re finished, tap the red button again to stop recording.

•	 Your video is automatically saved to the camera roll, alongside any other saved videos 
and still pictures. Now, you can perform simple edits right on your iPhone 3GS and 
iPhone 4.

b) Samsung

How to record video on the Samsung smartphone:

Select:

•	 Applications

•	 Camera

•	 Film Mode (icon)

Note – flip the direction to the way you want. (top right)

•	 Press Record (red button)

On the next page we address some common storytelling/video techniques.
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Option 2: Smartphones

a) iPhone (Instructions may vary 
according to what version you are 
using)

How to record video on Your 
iPhone:

> Tap the Camera icon on the Home screen. Your iPhone be-
comes a camera, with the screen as viewfinder.

> Drag the little onscreen button 
at the bottom-right corner of the 
display from the camera position 
to the video camera position. 

> (Optional) Tap the LED Flash 
button. Tapping this button shines 

a light while you record video.

> Tap the red record button at the bottom center to begin shoot-
ing a scene. The button blinks and a counter timing the length 
of your video appears. 

> When you're finished, tap the red button again to stop record-
ing.

> Your video is automati-
cally saved to the camera 
roll, alongside any other 
saved videos and still pic-
tures. Now, you can per-
form simple edits right on 
your iPhone 3GS and 
iPhone 4.

b) Samsung

How to record video on the 
Samsung smartphone:

Select:

> Applications

> Camera

> Film Mode (icon)

Note - flip the direction to the way you want. (top right)

> Press Record (red button)

In Section 2 we address some common storytelling/video tech-
niques.
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Option 3: iPad (Tablet)

How to record video on an iPad:!

•	 Tap the Camera icon on the Home screen.

•	 Drag the little onscreen button at the lower-right corner of the display from the camera 
position to the video camera position.

•	 Tap the front/rear camera button at the bottom-right corner of the screen when you’ve 
made your choice.

•	 Tap the red Record button on the middle right side of the screen to begin shooting a 
scene.

•	 Tap the red Record button again to stop recording.

•	 Your video is automatically saved to the Camera Roll, alongside any other saved videos 
and digital stills.

Section 2: Digital storytelling/video techniques 
(pre- production planning and shoot)

In this section we’ll cover four options as well as explore various narrative or storytelling 
strategies for video.

Option A: Single shot

The Single Shot filming technique does exactly what it says, everything is filmed in one shot 
with no need to edit together video footage.

There are two different ways to approach your video using this technique:

•	 You consider everything you intend to film including any camera movement and what 
happens within the frame i.e. people, composition or anything else significant.

•	 You might also consider using the technique in an observational approach. Allowing 
yourself to watch the world around you. This could be anything from an image that is 
significant to you or a scene you see everyday. You could film yourself or someone else. 
It could just be something you noticed in your day-to-day life. It could be an interesting 
observation or a metaphoric image.

You could if you choose add additional sound in postproduction using your PC or Mac. This 
could include music, voice over, sound design… anything sonic. Using narration or voice 
over is an effective way to tell your story.
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Option B: Edit on camera

This technique works best for people using tape camcorders, and is ideal for people who 
may not have access to or want to use editing software.

When you have developed your storyboard and story you will then need to plan exactly 
what you need to record. By recording only the shots you want in the order you want them 
to be in the film there will be no need for retakes or editing.

Steps to take:

• Setup your camcorder in the desired position (you may want to use a tripod) for the first 
shot in your film.

• Then press record for as long as you want the shot to be in the film and promptly press 
the record button again to stop.

• Then setup your camcorder for the next shot in the film, and repeat the process until you 
have finished your shot.

By limiting what you have to do technically you can focus on the story, ideas and specific 
images. Remember if you make a mistake just start again.

Remember, just because you decide to use this technique you don’t have to stick to it if it 
doesn’t work for you. We can always help you edit your shots later if you have the footage 
but are finding it difficult to get them all in the right order. Once again, you could add also 
include additional sound in post-production with our assistance.

Option C: Shoot and edit

This technique is the most conventional as it requires you to use editing software to cut 
together a selection of shots into a film to tell a story. For full details of how to do this 
please see ‘Narrative or digital storytelling strategies’ on the next page.

These are some suggestions of what approach you could use with this technique:

•	 You could use the video diary approach. Over a period of time you talk to the camera 
telling your story.

•	 You could write a story, create a shot list and shot a short fiction film.

•	 You could use your story that you have developed from your experiences to make a very 
short documentary. You don’t necessarily need to include yourself in the film.

•	 You could also do something more poetic or experimental film using images to tell a 
story instead of words. By putting images or shots together you can use montage to tell 
a story without words.
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Option D: Animate with stills

This technique can be used with a any recording device including: Stills camera, webcam, 
photocopier, flatbed-scanner, camcorder, phone, tablet.

Here are some suggestions:

•	 You could assemble a series of images to illustrate your story. This can be combined 
with music and narration to make anything from a documentary, fiction or maybe even a 
video diary using selections from what you say with the relevant still images.

•	 You could also use the stop-frame animation approach to bring to life a character (eg. 
plasticine figure, action figure, doll etc).

There are many other ways and combinations to use still images and sound to tell your 
story. The above are just general suggestions that we can expand on or use to trigger and 
explore other possibilities in the workshop or online.

Steps to take:

•	 Decide on your approach.

•	 Collect your still images and sound.

•	 Import to an editing software.

•	 Edit and export as you would video footage.

Narrative or digital storytelling strategies

Narration: On camera / off camera

If you are working alone, set your camera up on a tripod or stand. Press the video button to 
start filming, sit in front of the camera and begin telling your story. I do mean tell your story 
as opposed to reading your story. Look the viewer/camera in the eye and tell your story. 
You’re free to stop and start as you wish. Clips can be edited into a whole later on your 
computer using editing software.

If you have a friend or partner, you could ask them to film you speaking directly to the 
camera. It’s important to have a story to tell before you start. Don’t rely on your ability to 
improvise. It can help to have either scripted and rehearsed your story beforehand and film 
it in parts.

Otherwise, if working with a friend or partner have them interview you in a way that allows 
you to build your story in the order that you’ve determined beforehand. This means 
working with your partner to formulate the questions you want to answer. The interview 
might adopt the form of a conversation or dialogue.

You can decide if the interviewer will be off camera or included in the shot. And, of course, 
you can narrate the story yourself off camera, either recording yourself with the camera (if it 
has audio capability) or by adding your narration as an audio file (recorded on a digital 
recorder) later.
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A day in the life

You might structure your story over a typical day in your life. You film short clips of your 
activities morning, day and night that help tell the story of the challenges you face; and the 
pleasures you experience. Rather than do it all in the same day, shoot your clips over a 
week so that you can collect and use the best ones.

You might combine “speaking to the camera” techniques with an “eye-view” technique. 
“Eye-view” simply means shooting the scene from your point of view as if the camera is 
looking at what you see. Use sparingly as too much of one technique or another can 
become a little monotonous. Vary your angles. Give your audience something interesting to 
look at and remember that everything in the frame should be helping to tell your story.

Remember that your final video will only be three to five mins long so don’t overdue the 
length of your shots – vary the length, short three to five seconds and longer five to ten 
seconds with an occasional longer one. And remember too that all your shots can be 
edited.

Expressive narratives

If you have the confidence, you can try to be more expressive in your approach. There are 
no hard and fast rules. Don’t be afraid to play with your camera and your approach to your 
story. You might feel, for example, that your story is best expressed through you performing 
a dance, a poem or other text, telling a fairy tale, drawing a picture or painting an abstract, 
or through some other creative activity.

Light and shadow

Photography and film work are all about light and shadow. It’s not that you can’t shoot on a 
cloudy, grey day but by paying attention to light and shadow, you can create a more 
dramatic atmosphere whether indoors or outdoors. If indoors, move lights around, open/
close curtains and situate yourself in places where light and shadow come into play. Think 
about the mood or tone of the scene your shooting. Does your use of light and shadow 
complement the script? your message?

Backdrops

Keep backdrops simple. You don’t want the background distracting the viewer’s eye. On 
the other hand, a simple background can be effective in contributing to your story and 
character. A bookshelf of children’s books, for example, could suggest your love of that 
particular kind of reading; a certain painting on the wall behind you could complement your 
story; a coloured wallhanging might suggest a particular mood. Wood, plaster, concrete, 
stone, glass, textiles all have their own connotations. Use them thoughtfully. Beware 
interlopers hanging around in the background; don’t allow background distractions from 
your story.
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Using photographs

A very creative technique involves combining the use of liveaction video with photographs. 
Do you have meaningful photos? A great way of showing you and others in the past 
suggesting a “now and then” effect. Or simply an effective way of getting across the 
chronology or history of your experience.

You could also photograph objects that are important to you and include them in your 
video.

Note: Don’t use other people’s photos without their permission. Copying photos off the 
Internet will infringe the owner’s copyright. Either seek permission or use photos from a 
royalty-free web site such as shutterstock or istock – you will need to pay for these though.

Special effects

A number of creative effects can be added during the editing stage – titles, text, filters, 
narration, soundtrack etc. Both Windows Movie Maker and Apple Mac’s iMovie will give 
you some creative control over effects. However, don’t let effects detract from your story.

Music

Music has been a long-standing companion of storytelling on film. Music can lift a story and 
enhance its message. Remember that you want your musical choice to complement not 
compete with your story. If you choose a vocal, listen carefully to the lyrics and make sure 
they are relevant to your story.

While popular music is readily available on the Internet these days for download, there are 
some rules about using other people’s music. They come under the heading of copyright. 
Artists have a right to be paid and acknowledged for their work. You shouldn’t simply add 
your favourite track to your video without permission from the artist. In most cases this 
involves a long, complicated process with the record company and publisher as well. If you 
do use someone’s music without permission you run a very good risk of legal action. At the 
very least, your film/video will be removed from such sites as YouTube and Vimeo.

Note: Fortunately, there are some websites that allow you to download music for free or a 
small fee (see Resources section).

Uploading your videos and photographs

Once you’ve filmed and/or shot your photographs, you will want to upload them to your 
computer so you can start working with them in your editing software (Windows Movie 
Maker or Apple Mac’s iMovie or other video editing software). In a following section we will 
look at how to do that but first let’s prepare our files and folders for easy accessibility. And 
remember to save your work as you go.

Good luck. Have fun.
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Housekeeping
In this section we remind you of the importance of 
keeping your files and folders in order. There’s nothing 
worse than forgetting where you put your work or an 
important file, image or video clip – unless you forget to 
backup your work and you lose it all!

4
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Key points

1. Uploading your files from your device to computer.

2. Prepare folders on your desktop.

3. Renaming files.

4. Backing up your work.

Keeping your files in order

Before long, you will realise you have a number of video files on your camera/phone. Those 
files will be taking up space. You may also be recording narration, sound or music on a 
digital audio recorder so you may also have sound files to upload. It’s time to upload them 
to your computer or laptop.

First, you’ll have to upload your video and sound files to your computer or laptop. To do 
this, you’ll need the USB connector cord that came with your camera or phone. Connect 
your device to your and turn on your camera or phone (or audio recorder if you’re using 
one).

Next, you need to instruct the computer to copy the files to your Desktop. Prepare a new 
folder for storing them. Keep video files in a file called “Movies” or “Video” and sound files 
in a folder called “Audio” (or something similar). Photographs can be kept in a folder called 
“Photos”. Remember to name folders and files with names that make it easy to identify 
what’s in them. Keeping files on your Desktop makes them easy to locate.

Renaming files

When you look at the files you’ve just uploaded from you camera or phone, you will notice 
that they do not have user-friendly labels. They might read something like “DSC600180914” 
or some other combination of letters and numbers. If you’re confident, try renaming the 
files you want to use to something that describes what they are. Normally you can right-
click (Windows) or Ctrl-click (Mac) on the file and select “Rename” in the menubar that 
comes up.

Backups

I can’t stress the importance of backing up your work. Unless you’re prepared to lose your 
hard-earned work and start all over, you should be backing up your video work onto an 
external hard-drive or USB or Flash memory stick/card. Alternatively, if your computer has a 
DVD/CD player, you could save your work onto a recordable CD although you’re advised to 
use a recordable DVD which can accommodate much larger files like video.

Ok, now that we’ve addressed the issue of housekeeping, let’s move onto the creative art of 
editing our video and photographs. It’s in this phase of our work that our videos really take 
shape.
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Importing your video
In this section, we explore how to import your video into 
Windows Movie Maker and Apple’s iMovie.

5
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Key points

1. Importing video to Windows Movie Maker

2.  Importing video to Apple Mac iMovie.

Importing your video

Once your video files and/or sound files are uploaded to your computer or laptop, you can 
now begin the process of importing them into your editing software like Windows Movie 
Maker or Apple’s iMovie.

The following instructional videos from the Vimeo Video School will be invaluable. They 
cover all aspects of video creation from beginning to end.

Mac iMovie https://vimeo.com/17861156

Windows Movie Maker https://vimeo.com/17857159

You will also find other videos in the series to help with all aspects of importing, editing and 
exporting your video stories. Remember, depending on your version of software, the 
images in the videos may look slightly different than on your computer. However, there 
should enough resemblance to allow you to follow the instructions without any difficulty.

If this is your first time using your video editing software, don’t become disheartened if you 
don’t quite get the hang of it. Be patient and persevere. There is a bit of a learning curve 
but with time you can produce some satisfying results. Most software has far more features 
than you need so stick with a few simple ones like transitions. Try to be consistent in your 
use of them. If you use too many different features you will distract your audience from the 
story, which is, after all, the most important reason for the film in the first place.

https://vimeo.com/17861156
https://vimeo.com/17857159
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Part 1: Importing video

a) iMovie HD: How to get started on iMovie:

a) SETTING UP

 Select

•	 Create a New Project

i) Name project

ii) Select location to save project

iii) Select Video Format

b) IMPORTING

•	 Digital Video (tapeless camcorder, smart phone, tablet)

•	 Select

•	 File > Import

•	 Then find the files you want to edit.

 Tape (DV/HDv camcorder)

 Select

•	 File > Make a Magic iMovie

•	 Enter name into Movie title > Select “Rewind the tape before capturing the movie”

•	 Deselect everything else > Create

b) Windows Movie Maker: How to get started on Movie Maker:

a) SETTING UP

 Select

•	 Create a New Project

i) Name project

ii) Select location to save project

iii) Select Video Format

b) IMPORTING

 Digital Video (tapeless camcorder)

 Select

•	 File > Import Media Items.

 Navigate to the location that contains the digital media files you want to import, and 
then click Import.
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Tape (DV/HDv camcorder)

•	 Connect camcorder to PC with USB 2.0 connection

•	 Set the camera mode to play recorded video (often labeled VTR or VCR on a DV 
camera).

•	 In the Autoplay dialog box that displays when you turn on the DV camera, click Import 
Video.

•	 In the Name box, type a name for the video file or files that you will create, import, and 
then save to your computer.

•	 Choose a location to save your video file from the Import to list, or click Browse to 
choose another location.

•	 In the Format list, choose Windows Media Video (one file per scene).

•	 Click Import the entire videotape to my computer, and then click Next.

•	 If you want to stop importing video before the end of the videotape, click Stop, and 
then click Yes.

•	 Click Finish.

•	 The imported video is saved as one or more video files on your computer and appears 
in Windows Photo Gallery.
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Editing your video
In this section you’ll be shown how to edit your video 
using Windows Movie Maker or Apple’s iMovie.

6
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Key points

1. Editing is easy in Apple’s iMovie or Windows Movie Maker.

2. Create a timeline, cut and paste using ‘drag and drop’.

3. Add fade in and fade out and other effects.

4. Edit audio.

5. Add voiceover, if required.

Editing your video

Editing in iMovie

i) Timeline

After you have imported your video and sound footage you must now drag down what clips 
you want to use on to the time line.

•	 Click on Timeline View. This is 
a clock symbol.

•	 Then click and drag the clips 
you want to work on to the 
timeline.

•	 Assemble the clips to match 
your storyboard.

ii) Cutting

Once this is done you can start to shorten or cut your clips.

•	 Press play on the timeline and stop where you want to cut.

•	 Hold down “Command” (Apple key) and press “t” at the same time.

Or to do the same thing:

Select > File > Split Video Clip at Play Head

Key Points

1. Editing is easy in Apple’s iMovie or Windows 
Movie Maker.

2. Create a timeline, cut and paste using ‘drag and 
drop’.

3. Add fade in and fade out and other effects.

4. Edit audio.

5. Add voiceover, if required.
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Editing Your Video

Editing in iMovie

i) Timeline

After you have imported your video and sound footage you 
must now drag down what clips you want to use on to the time 
line.

! > Click on Timeline 
View. This is a clock 
symbol.

! > Then click and 
drag the clips you want 
to work on to the time-
line.

> Assemble the clips to 
match your storyboard.

ii) Cutting

Once this is done you can start to shorten or cut your clips.

! > Press play on the timeline and stop where you want to 
cut.

Section 1

Editing Your Video
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iii) Shortening the video

Also to simply shorten a video clip:

•	 Hover the mouse cursor over either end of the clip on the timeline.

•	 Then click and drag to the desired length.

iv) Adding video fades

To slowly fade in/out the sound:

Select > Editing (on the timeline) > Transitions

Then click and drag “Fade In” (or Fade Out) to the 
end of the desired video clip on the timeline.

v) Edit audio

a) Turn off audio

•	 To turn off the audio on the video clip simply 
de-tick the box to the right of the video on the 
timeline.

b) Adding audio

•	 To add additional audio import it the same way 
as video:

•	 Select > File > Import

•	 Then find the audio files you want to edit.

c) Voiceover

To add voiceover to your video you can record it via iMovie.

•	 Click on Media on a red button will appear

•	 Press the red button to record and again to stop

The audio will appear on your timeline.
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! > Hold down “Command” (Apple key) and press “t” at the 
same time.

Or to do the same thing:

Select > File > Split Video Clip at Play Head

iii) Shortening the Video

Also to simply shorten a video clip:

> Over the mouse cursor over either end of the clip on the time-
line. 

> Then click and drag to the desired length.

iv) Adding Video Fades

To slowly fade in/out the sound:

! Select > Editing (on the timeline) > Transitions
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Then click and drag “Fade In” (or Fade Out) to the end of the 
desired video clip on the timeline.

EDIT AUDIO

i) Turn off Audio

To turn off the audio on the 
video clip simply de-tick the 
box to the right of the video on 
the timeline.

ii) Adding Audio

To add additional audio import 
it the same way as video:

! Select > File > Import

! Then find the audio files you want to edit.

iii) Voiceover

To add voiceover to your video you can record it via iMovie.

! > Click on Media on a red button will appear

! > Press the red button to record and again to stop

The audio will appear on your timeline.

iv) Sound Level

To change the sound volume of your audio levels: 

! Select > View > “Show Clip Volume Levels” 
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iv) Sound level

To change the sound volume of your audio levels:

Select > View > “Show Clip Volume Levels”

Then click and drag the line that appears in the audio bar on the timeline.

Editing in Windows Movie Maker

i) Timeline

After you have imported your video and sound footage you must now drag down what clips 
you want to use on to the time line.

•	 Click on Timeline View. This is a clock symbol.

•	 Then click and drag the clips you want to work on to the timeline.

•	 Assemble the clips to match your storyboard.

ii) Cutting

a) Split clips

•	 In the Contents pane or on the storyboard/timeline, click the video or audio clip that you 
want to split.

•	 Under the preview monitor, click the Play button .

•	 When the clip reaches a point near the place you want to split the clip, click Pause.

•	 Under the preview monitor, use the playback controls to find the point where you want 
to split the clip.

•	 Under the preview monitor, click the Split button.

b) Combine clips

•	 In the Contents pane or on the storyboard, hold down the CTRL key, and then click the 
contiguous clips you want to combine.

•	 Click Clip, and then click Combine.

Note: The name and property information of the first clip in the group is used for the new 
clip and the time is adjusted accordingly.
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c) Trim clips

•	 If you are in the storyboard view, click View, and then click Timeline.

•	 On the timeline, click the clip that you want to trim.

•	 Use the playback controls under the preview monitor to find the point where you want 
to trim the clip.

•	 When the playback indicator is at the point where you want the selected video or audio 
clip to start playing back, click Clip

•	 Then click Trim Beginning.

•	 When the playback indicator is at the point where you want the selected video or audio 
clip to stop playing back, click Clip

•	 Then click Trim End.

iii) Adding video fades

Transitions

•	 On the storyboard/timeline, click the second of the two video clips, titles, or pictures 
that you want to add a transition between.

•	 Click Tools, and then click Transitions.

•	 In the Contents pane, click the transition that you want to add.

Note: You can click Play under the monitor to see a preview of what the transition looks like.

•	 Click Clip, and then click Add to Timeline or Add to Storyboard.

Transition Duration

The amount of overlap between two clips determines the transition duration. At times, you 
might want to make the transition shorter or longer.

•	 To view the Transition track of the timeline, expand the Video track.

On the Transition track of the timeline, do one of the following:

•	 To reduce the transition duration, drag the beginning of the transition towards the end 
of the timeline.

•	 OR ... To increase the transition duration, drag the beginning of the transition towards 
the beginning of the timeline.
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iv) Edit audio

a) Turn off audio

To turn off the audio on the video clip simply de-tick the box to the right of the video on 
the timeline.

b) Adding audio

To add additional audio import it the same way as video:

Select > File > Import

Then find the audio files you want to edit.

c) Voiceover

To add voiceover to your video you can record it via iMovie.

•	 Click on Media on a red button will appear

•	 Press the red button to record and again to stop

The audio will appear on your timeline.

v) Sound level

To change the sound volume of your audio levels:

Select > View > “Show Clip Volume Levels”

Then click and drag the line that appears in the audio bar on the timeline.

How to edit video on your iPhone:

•	 Tap a video recording you’ve saved. The on-screen videoediting controls appear.

•	 Drag the start and end points along the timeline to select only the portion of the video 
that you want to keep.

•	 Hold your finger over the section to expand the timeline so that you can more easily 
apply your edits. You can tap the play button to preview the edit.

•	 Tap Trim. The iPhone gives you a couple of trimming options.

•	 Tap Trim Original to permanently remove scenes from the original clip.

Alternatively, you can tap Save as New Clip to create a newly trimmed video clip; the 
original video is unaffected, and the new clip is stored in the Camera Roll. Or tap Cancel to 
start over.
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iv) Sound Level

To change the sound volume of your audio levels: 

!Select > View > “Show Clip 
Volume Levels” 

Then click and drag the line that 
appears in the audio bar on the 
timeline.

How to edit video on your 
iPhone:

> Tap a video recording you've 
saved. The on-screen video-
editing controls appear.

> Drag the start and end points 
along the timeline to select only 
the portion of the video that you 
want to keep.

> Hold your finger over the section to expand the timeline so 
that you can more easily apply your edits. You can tap the play 
button to preview the edit.

> Tap Trim. The iPhone gives you a couple trimming options.

> Tap Trim Original to permanently remove scenes from the 
original clip.

Alternatively, you can tap Save as New Clip to create a newly 
trimmed video clip; the original video is unaffected, and the new 
clip is stored in the Camera Roll. Or tap Cancel to start over.

Next: Exporting and Sharing Your Video
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Exporting and 
sharing your video
In this final section we show you how to export your 
finished video and share it on popular videosharing sites 
like YouTube and Vimeo.

7
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Key points

1. Exporting video from Windows Movie Maker

2. Exporting video from Apple Mac’s iMovie

3. Sharing video on YouTube

4. Sharing video on Vimeo

Preparing your video for export

In this next section, you will learn how to export your finished video so that you can share it 
with others via social networking sites like YouTube, Vimeo, Facebook etc.

Fortunately, there is lots of help on the Internet showing you how to export your video 
whether you’re using Windows Movie Maker or Apple Mac’s iMovie. I’ve offered some links 
below but feel free to search for others.

Windows Movie Maker: the following link will take you to a “how-to” section from Microsoft 
explaining how to export video from Windows Movie Maker.

http://windows.microsoft.com/en-gb/windows-vista/publish-a-movie-in-windows-
movie-maker

This link takes you to a video explaining how to export video from Windows Movie Maker.

http://youtu.be/YZXuFQzemAw

Apple Mac iMovie: the following link will take you to a “how-to” page describing how to 
export video using Apple Mac’s iMovie.

http://support.apple.com/kb/PH2285

This link takes you to a video explaining how to export video using Apple Mac’s iMovie ’09. 
There are videos describing how to do this using iMovie ’11.

http://youtu.be/joqPAPdUVZg (iMovie ’09)

http://youtu.be/SsF-aKNUS_U (iMovie ’11)

http://windows.microsoft.com/en-gb/windows-vista/publish-a-movie-in-windows-movie-maker
http://windows.microsoft.com/en-gb/windows-vista/publish-a-movie-in-windows-movie-maker
http://youtu.be/YZXuFQzemAw
http://support.apple.com/kb/PH2285
http://youtu.be/joqPAPdUVZg (iMovie �09)
http://youtu.be/SsF-aKNUS_U (iMovie �11)
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Exporting for Vimeo or YouTube

(iMovie)

•	 Select > File > Export > Full Quality > Share

(Windows Movie Maker)

•	 Click File > Publish Movie.

•	 Click This computer > click Next.

•	 In the File name box, type a name for your movie.

•	 In the Publish to box, choose where you want to save your movie once it’s published, 
and then click Next.

•	 Choose the settings you want to use to publish your movie, and then click Publish.

•	 If you want to watch your movie after it has been published, select the Play movie when I 
click Finish check box.

•	 Click Finish

How to upload videos to YouTube:

You are not limited in the amount of videos that you can upload. But you are limited to the 
length of the video (under 10 minutes) and the size of the file (under 2GB). Youtube does 
some compressing to your videos on their end so it’s best to aim for the highest quality 
video possible for exporting. Try settings that allow you to keep the original video 
resolution while staying within the 2GB file limit.

•	 Then go to the Youtube home page (Youtube.com) and log into your account. Then click 
on the Upload link.

•	 Click on the ‘Upload Video’ button. A window will pop up allowing you to browse your 
hard drive for the video file. Once you choose the file it will automatically begin to upload.

•	 While the video uploads you can enter information about the video. This includes a title, 
description, tags and the option to make the video private or public. If your video is still 
uploading after you have finished entering this information then just click save changes 
and they will be applied after the video is uploaded.

•	 Once the upload is complete it is not immediately available for viewing. Remember, 
Youtube does some compressing on their end which they call processing. Depending 
on the size of your video it may not be available for viewing for a few minutes. But once 
it’s complete your video is ready to be shared with the world.
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How to upload videos to Vimeo:

•	 The first thing that you should do is visit the Vimeo website. If you already have an 
account, log into it by clicking the login link. If you don’t have an account, then you will 
need to register. Follow the instructions and enter the necessary information to create 
your account.

•	 Click the “Upload Video” button which is located on the home page of the site. You will 
also be able to find the same link in the navigation bar, which is under the Upload 
heading. Once you click the upload link, you will be taken to the upload page.

•	 Click the “Choose a File to Upload” button and this will launch an upload dialog box. 
Choose the file that you want to upload and then click on “Select”. As soon as you click 
the button, the video will start to be uploaded straight away. The progress bar should 
estimate how long the video will take to be uploaded.

•	 As soon as the video is uploaded, the video will then be converted automatically. You 
can close this page if you want, and Vimeo will handle the conversion automatically. 
Once the video has finished converting, the service will then email you once the 
conversion has finished.

Using the Desktop Uploader

If you are interested in uploading lots of files, then you will need to use the desktop 
uploader. This is optional, but will make uploading files much simpler.

•	 Click the download button to download the uploader to your computer.

•	 Accept the license details, and save the file on your computer.

Follow all the instructions to install the application on your computer. This will then walk you 
through the process of uploading files to the service.

How to upload videos to Dropbox

•	 Install the Dropbox desktop application. It creates a new folder on your computer called 
Dropbox. Your Dropbox folder works just like any other folder on your hard drive, except 
everything in your Dropbox folder automatically syncs to the web and to any other 
computer with Dropbox installed.

•	 It’s easy to add files to Dropbox. Move 
your files into your Dropbox by 
dragging and dropping them into your 
Dropbox folder. The files in your 
Dropbox folder will automatically be 
synced online and to your other 
computers. You don’t have to do 
anything. You can even use the Save 
As... menu option in most applications 
to save files directly to your Dropbox 
folder.
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How To upload videos to Dropbox:

> Install the Dropbox desktop application. It creates a new 
folder on your computer called Dropbox. Your Dropbox folder 
works just like any other folder on your hard drive, except every-
thing in your Dropbox folder automatically syncs to the web and 
to any other computer with Dropbox installed.

> It's easy to add files to Dropbox. Move your files into your 
Dropbox by dragging and dropping them into your Dropbox 
folder. The files in your Dropbox folder will automatically be syn-
ced online and to your other computers. You don't have to do 
anything. You can even use the Save As... menu option in most 
applications to save files directly to your Dropbox folder. 

After installation on Mac OS X, we recommend that you upload 
via the website:

> Sign in to the Dropbox website.

> Click the Upload button from the very top of the window.
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After installation on Mac OS X, we recommend that you upload via the website:

•	 Sign in to the Dropbox website.

•	 Click the Upload button from the very 
top of the window.

•	 A window will appear. Click the Choose 
File button and then select the file on 
your computer that you’d like to add to 
your Dropbox.

•	 Choose as many files as you like, and 
then click the Start Upload button.

The window will disappear, your files will 
start uploading, and you’ll be shown a 
progress indicator.

Note: Each file you upload through the 
website must be 300 MB or less. For larger 
files, use the desktop application or 
mobile app, which don’t have this limit.

If you use Chrome, Firefox, or Safari, you 
can upload files by dragging them from 
your desktop onto the Dropbox website.
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Resources
This section offers links to web-based resources for free 
music, sound effects, photos and video.

“If, in the digital age, we want everyone to be able to join 
in the conversation that Big Media promises to be, then we 
must intervene to help everyone – and not just those who are 
computer savvy – to speak the language of media.”
Daniel Meadows, Lecturer in Photography and Participatory Media, Cardiff University

8
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Key points

1. Free music

2. Free sound effects

3. Video sharing sites

4. How-to videos and digital storytelling resources

Free music

At some point you may want to add music to your video. With so many music download 
sites, it would seem a simple thing to go to iTunes or Amazon, pay for a track and use it on 
your video. Wrong!

While music can certainly add emotional impact to your story, you must respect copyright. 
In other words, do not use anyone’s music without their permission. To do otherwise is 
piracy and subject to prosecution. YouTube and Vimeo and many other social networking 
sites will take down any videos that contravene copyright law.

Fortunately, there are sites which offer “free music downloads” and we’ve listed a few 
below. However, a word of warning: increasingly criminals are targeting and setting up such 
sites as a way of spreading viruses and spyware.

So, take care when seeking “free music”. Read reviews which identify the more trusted sites 
and ensure that your anti-virus software is up to date. If in any doubt about a site offering 
“free music” don’t do it. And certainly don’t give credit card or other personal details to any 
website in exchange for a “free download”.

Other options include recording your own music and by that we mean music that you make 
– perhaps you play the piano or guitar or some other instrument. Or, you can ask your 
musical friends to record a piece for you. I once contacted a band in Bristol whose music I 
liked and asked if they would mind me using a track of their music. To my delight, they 
replied and offered me five tracks to choose from without any compensation. All they asked 
for was a credit on my video which I was more than happy to give.

Here are a few sites, which at the time of writing this, seem to be trustworthy and offer 
genuine “free music downloads” under the Creative Commons license (see  
www.creativecommons.org). You won’t find the latest hits here but you will find an array of 
interesting instrumental and vocal tracks in a variety of genres from lesser known artists who 
have agreed to share their music. While every effort has been made to ensure the 
reputation of these sites, Action for M.E. cannot guarantee them. As with anything on the 
Internet, use common sense.

www.freemusicarchive.org

www.freeplaymusic.com

www.mobygratis.com

www.soundcloud.com

www.bandcamp.com

Check www.creativecommons.org for a list of other sites.

www.creativecommons.org
www.freemusicarchive.org
www.freeplaymusic.com
www.mobygratis.com
www.soundcloud.com
www.bandcamp.com
www.creativecommons.org
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Sound effects

Like music, recorded sound effects are also subject to copyright law. However, there are a 
number of sites where sound effects are available either for a small fee or for free. Again, 
these sites operate under the auspices of Creative Commons licensing.

www.freesound.org
www.soundbible.com
www.freesfx.co.uk

Video sharing sites

The following are three of the most popular video-sharing websites on the Internet. You will 
have to create an account in order to upload your videos.

YouTube www.youtube.com
Vimeo www.vimeo.com
Facebook www.facebook.com

How-to videos

There are literally thousands of “how-to” pages and videos on the Internet instructing you 
how to do just about anything, including creating a digital storytelling video. If someone 
has done it, it’s likely they’ve made a video or web page showing you how. The easiest way 
of finding material is to put your search terms in Google and start looking.

However, below you will find a list of sites dedicated to the art of digital storytelling. Each is 
dedicated to celebrating the creation of digital stories and sharing the practice with hands-
on tutorials and other help.

Wikipedia – a useful definition and outline of digital storytelling 
https://en.wikipedia.org/wiki/Digital_storytelling

Centre for Digital Storytelling – in addition to offering inspirational video stories made by 
others, the Centre offers online courses in digital storytelling and other useful resources. 
http://storycenter.org/

University of Houston Digital Storytelling Centre – The University’s College of Education 
provides a good online resource for teachers and students interested in learning more 
about digital storytelling. http://digitalstorytelling.coe.uh.edu/

BBC Wales – Based on the BBC Capture Wales project that ran from 2001 to 2008, this BBC 
audio and video unit has an indepth guide to digital storytelling available as well as many 
other valuable resources.  
http://www.bbc.co.uk/wales/audiovideo/sites/galleries/pages/digitalstorytelling.shtml

Photobus – inspired by the previous project, lecturer and film maker Dan Meadows 
celebrates his love of digital storytelling and offer plenty to keep you busy and inspired. 
http://www.photobus.co.uk/?id=534

Vimeo – a well-known and trusted site with film-makers. You can set up your own account 
and upload your films for private or public viewing. Vimeo also offers lots of support and 
useful resources for creating, editing and sharing videos. 
http://www.vimeo.com

www.freesound.org
www.soundbible.com
www.freesfx.co.uk
www.youtube.com
www.vimeo.com
www.facebook.com
https://en.wikipedia.org/wiki/Digital_storytelling
http://storycenter.org/
http://digitalstorytelling.coe.uh.edu/
http://www.bbc.co.uk/wales/audiovideo/sites/galleries/pages/digitalstorytelling.shtml
http://www.photobus.co.uk/?id=534
http://www.vimeo.com
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